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PlanAhead ソフ トウェア チュート リアル :  
Tcl および SDC コマンドの使用

概要

このチュート リ アルでは、 PlanAhead™ ソフ ト ウェアを使用して Tool Command Language (Tcl)
API でスク リプ ト を記述する方法について説明します。 PlanAhead ソフ ト ウェアのグラフ ィカル

ユーザー インターフェイス  (GUI) およびプロジェク ト  フローについては、 既に理解しているこ と

が前提になっています。 

まだ理解していない場合は、付録 A 「その他のリ ソース」 に示す PlanAhead チュート リ アルの 「ク

イ ッ ク  フロー 概要」 を実行し、 基本的な機能を試してください。

このチュート リ アルでは、 ISE® Design Suite ソフ ト ウェアの一部と して含まれる  PlanAhead ソフ

ト ウェアの機能を使用しています。

チュート リアルの目標

このチュート リ アルでは、 次を実行します。

• サンプル デザインを使用して、 Tcl コンソール、 GUI と  Tcl コマンド間の関係、 およびログ

ファイル/ジャーナル ファ イルなどを確認します。

• Tcl およびバッチ スク リプ ト を使用して PlanAhead プロジェク ト を開きます。

• PlanAhead の GUI、 Tcl コンソール、 Tcl コマンドのオンライン ヘルプについて理解します。

• PlanAhead のさまざまな実行モードについて学びます。

• 基本的な Tcl ビルト イン コマンドをいくつか実行します。

• バッチ モード  プロジェク ト を作成し、 フローを実行するスク リプ ト を作成します。

• Tcl オブジェク ト、 プロパティ、 物理制約を確認します。

• UCF タイ ミ ング制約を同等の Synopsys デザイン制約 (SDC) に簡単に変換し、 インク リ メン

タルなスタティ ッ ク  タイ ミ ング解析レポート を確認します。

http://japan.xilinx.com
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はじめに

はじめに 

ソフ トウェア要件

PlanAhead ソフ ト ウェアは、 ISE Design Suite ソフ ト ウェアをインス トールする と インス トールさ

れます。チュート リ アルを始める前に、PlanAhead が起動できるか、チュート リ アル デザイン デー

タがインス トールされているかを確認して ください。 

インス トール方法およびその詳細は、 付録 A 「その他のリ ソース」 に示される 『ISE Design Suite :
インス トールおよびライセンス  ガイ ド』 (UG798) を参照してください。

ハードウェア要件

大規模デバイスで PlanAhead ソフ ト ウェアを使用するには、2GB 以上の RAM が推奨されます。こ

のチュート リ アルでは、小型の XC6VLX75T デザインを使用し、1 度に開く こ とができるデザイン

数を制限していますので、 1GB で十分ですが、 パフォーマンスに影響のでるこ と もあ り ます。 

チュート リアル デザインの説明

この演習では、Wishbone バス  アービタを介して複数のペリ フェラル コアに接続される  RISC CPU
コアを含む小型のサンプル デザインを使用します。このデザインは、XC6VLX75TFF784 デバイス

をターゲッ トにしています。このチュート リ アルでは、既に合成済みで使用可能な HDL を含むプロ

ジェク ト  ファ イルを使用します。

チュート リアル デザイン ファイルのディ レク ト リ

このチュート リ アルでは、PlanAhead ソフ ト ウェアのプロジェク ト例に含まれるデザイン データを

使用します。 このデータは、 次からも入手できます。

1. 次のいずれかから、 PlanAhead_Tutorial.zip ファ イルをダウンロード します。

• PlanAhead ソフ ト ウェア インス トールのプロジェク ト例のディレク ト リ  :
<ISE_install_area>/PlanAhead/testcases/

• ザイ リ ンクスのウェブサイ ト  : http://japan.xilinx.com/support/documentation/
dt_planahead_planahead13-1_tutorials.htm

2. 書き込み権のあるディ レク ト リに ZIP ファ イルを抽出します。 

解凍された PlanAhead_Tutorial データ  ディ レク ト リは、このチュート リ アルでは <Extract_Dir> と
記述します。

チュート リ アルのサンプル データは、チュート リ アルを実行中に変更されます。各チュート リ アル

を実行する前に、 まず元の PlanAhead_Tutorial データのコピーを取っておいてください。 

Tcl 構文

このチュート リ アルには、Tcl コンソールで PlanAhead へ入力するコードが含まれます。Tcl 構文は、

太字の > の右側に表示される部分になり ますので、そのコマンドを Tcl コンソール ウ ィンド ウに入

力します。 たとえば、 次のよ うな構文がある と します。

>get_cells cpuEngine

cpuEngine

> 文字は、 タイプするテキス ト を示し、その下にそのコマンドに対するレスポンスが表示されます。

http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&ver=13.1&topic=planahead+tutorials
http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&ver=13.1&topic=planahead+tutorials
http://japan.xilinx.com
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チュート リアルの手順

このチュート リ アルは、 次の手順で構成されています。

• 「手順 1 : プロジェク ト を開く」

• 「手順 2 : Tcl コンソールおよびオンライン ヘルプの確認」

• 「手順 3 : Tcl スク リプ トの実行」

• 「手順 4 : 基本的な Tcl ビルト イン コマンドおよび構文の確認」

• 「手順 5 : 新規プロジェク トの作成、 合成およびインプリ メンテーシ ョ ン」

• 「手順 6 : ネッ ト リ ス ト  オブジェク ト、 プロパティ、 物理制約の確認」

• 「手順 7 : Tcl および SDC を使用したスタティ ッ ク  タイ ミ ング解析」

http://japan.xilinx.com
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手順 1 : プロジェク ト を開く

手順 1 : プロジェク ト を開く

PlanAhead では、使用されるデザイン フローの段階によってさまざまなタイプのプロジェク ト を作

成できます。RTL (レジスタ転送レベル) ソースは、開発、解析、合成、インプリ メンテーシ ョ ン、BIT
ファ イル生成などのプロジェク ト を作成するために使用できます。 このチュート リ アルでは、 まだ

インプリ メン ト されていない合成済みネッ ト リ ス ト  プロジェク ト を使用します。

PlanAhead ソフ トウェアの起動

PlanAhead ソフ ト ウェアを起動するには、 次の手順にしたがってください。

• Windows の場合、 Xilinx PlanAhead 13.1 のデスク ト ップ アイコンをダブルク リ ッ クするか、

[スター ト ] → [プログラム] → [Xilinx ISE Design Suite 13.1] → [PlanAhead] → [PlanAhead]
をク リ ッ ク します。

• Linux の場合は、<EXTRACT_DIR>/PlanAhead_Tutorial/Tutorial_Created_Data ディ

レク ト リに移動し、 planAhead と入力します。

PlanAhead の Getting Started ページが開きます。

プロジェク ト例を開く  
サンプル デザイン プロジェク トのネッ ト リ ス トは、チュート リ アルを実行中に変更されます。元の

チュート リ アル デザイン プロジェク ト を後で再利用できるよ うに、プロジェク ト を別名で保存しま

す。 

1. Getting Started ページで [Open Example Project] → [CPU (Synthesized)] をク リ ッ ク します。

2. [File] → [Save Project As] をク リ ッ ク し、 プロジェク ト を別名で保存します。

[Save Project As] ダイアログ ボッ クスが開きます。

3. [Project name] テキス ト  ボッ クスにプロジェク ト名を入力します (例 : project_tcl)。

4. プロジェク ト  ディ レク ト リに次を指定します。

<EXTRACT_DIR>/PlanAhead_Tutorial/Tutorial_Created_Data/

5. [OK] をク リ ッ ク します。

Project Manager が開き、 [Sources] ビューにデザイン ソースが表示されます。

6. PlanAhead 環境の左側の Flow Navigator で [Netlist Design] をク リ ッ ク します。

[Netlist Design] ビューが開きます。

Figure X-Ref Target - Figure 1-1

図 1-1 : プロジェク トの保存

http://japan.xilinx.com
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Figure X-Ref Target - Figure 1-2

図 1-2 : [Netlist Design] 環境のプロジェク ト

http://japan.xilinx.com
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手順 2 : Tcl コンソールおよびオンライン ヘルプの確認

PlanAhead をデフォルトの GUI モードで起動する と、 PlanAhead 環境の一番下の [Tcl Console]
ビューに GUI で実行された操作に関する メ ッセージが表示されます。[Tcl Console] ビューには、Tcl
コマンドを直接入力できるテキス ト  ボッ クス と スク ロール可能な履歴が表示されます (図 1-3)。 

[Tcl Console] ビューおよびメ ッセージを確認

1. [Tcl Console] ビューのテキス ト  ボッ クスに次の Tcl コマンドを入力します。

>puts “Hello!”

次の出力がコンソールの履歴に表示されます。 

Hello!

Tcl ビルト イン コマンドの puts を使用する と、文字列メ ッセージがコンソールと ログ ファ イ

ルの両方に出力されます。 

オンライン ヘルプを確認

1. [Tcl Console] ビューのテキス ト  ボッ クスに次の Tcl コマンドを入力します。

>help

コマンド  カテゴ リの リ ス トが表示されます。 

その他の help コマンド構文は、 次のとおりです。

• 指定したカテゴ リのコマンドを リ ス トするには、 次を入力します。

help -category <category name> 

• PlanAhead ソフ ト ウェアの Tcl コマンドの全リ ス ト を簡単な説明と共に表示するには、 次を入

力します。 >help *

特定のコマンドに関するヘルプを表示

1. [Tcl Console] ビューのテキス ト  ボッ クスに次のコマンドを入力します。

>create_project –help 

メモ : help create_project と入力しても同じです。

create_project コマンドのヘルプ構文がすべて表示されます。 

Description: 

Create a new project

Syntax: 

create_project [-part <arg>] [-force] [-quiet] <name> <dir>

Returns: 

Figure X-Ref Target - Figure 1-3

図 1-3 : PlanAhead の [Tcl Console] ビュー

http://japan.xilinx.com
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new project object

Usage: 

  Name    Optional  Default  Description

  --------------------------------------

  -part   yes                Set the default Xilinx part for a project

  -force  yes                Overwrite existing project directory

  -quiet  yes                Ignore command errors

  <name>  no                 Project name

  <dir>   no                 Directory where the project file is saved

2. [Tcl Console] ビューに次のよ うな無効なコマンドを入力してみます。

>junk

ERROR: invalid command name "junk"

Tcl インタープリ タによ り、 エラー メ ッセージが表示されます。

メモ : [Tcl Console] ビューのスク ロールバーの横に小さな赤いバーが表示されます。 これは、

その行でエラーがあったこ とを示します。 この方法を使用する と、 コマンド履歴をスクロール

して、警告やエラー メ ッセージを素早く確認できます。警告は黄色、 エラーは赤色で表示され

ます。 警告は黄色、 エラーは赤色で表示されます。

コマンドを Tcl コンソールに入力する と、Tcl インタープリ ターが既知のコマンド と定義済みプ

ロシージャを検索します。そのコマンドが見つからなかった場合は、OS シェルにそのコマンド

を送信します。既知のコマンドが検出されなかった場合は、エラー メ ッセージが表示されます。

OS シェル コマンドを入力

1. [Tcl Console] ビューに次を入力します。

• >dir (Windows)

• >ls (Linux)

現在作業中のディ レク ト リにあるファ イルすべてが表示されます。 この機能は、 OS 別コマンドに

Tcl インタープリ ター内から直接アクセスするために使用できます。 Tcl ビルト イン コマンドの

exec コマンドを使用するこ と もできます。 [Tcl Console] ビューに help exec と入力する と、 こ

のコマンドの詳細を確認できます。 

ログ ファイルとジャーナル ファイルを確認

PlanAhead を起動するたびに、 Tcl スク リプ トの作成を理解するのに便利な次の 2 つのファイルが

作成されます。 

• ジャーナル ファ イル (planAhead.jou) - ジャーナル ファ イルには、 [Tcl Console] ビューに入力

されたコマンド、 スク リプ トからのコマンド、 Tcl コマンド と同等の GUI で実行されたコマン

ドなど、 セッシ ョ ン中に実行されたすべてのコマンドの履歴が含まれます。

• ログ ファ イル (planAhead.log) - ログ ファ イルにはすべてのジャーナル コマンドが含まれる

ほか、 コマンドを実行するこ とで作成された情報、 警告、 エラー メ ッセージも含まれます。 こ
のファ イルには、 実行されたコマンドの内容が含まれます。 

ジャーナル ファ イルは、該当するコマンドの Tcl 構文を理解するのに便利です。たとえば、GUI コ
マンドを使用してからこのファイルを開く と、 実行された操作の Tcl 構文を確認できます。

http://japan.xilinx.com
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メモ : ジャーナル ファ イルと ログ ファ イルは、Linux の場合 PlanAhead 実行ファイルを起動する現

在作業中のディ レク ト リにあ り ます。Windows の場合、このディ レク ト リは %APPDATA% 環境変

数で定義されています。 この変数は、 通常次のディ レク ト リにマップされます。

C:\Documents and Settings\<user_name>\Application Data\Xilinx\PlanAhead

(Window XP の場合)
C:\Users\<user_name>\AppData\Roaming\Xilinx\PlanAhead (Windows 7 の場合)

1. planAhead.log および planAhead.jou ファ イルを確認します。 

2. 上記で実行したコマンド と、 情報、 警告、 エラー メ ッセージが表示されているはずです。

メモ : ジャーナル ファ イルと ログ ファ イルは PlanAhead を起動するたびに上書きされますので、こ

れらのファイルが今後必要な場合は、 保存しておいてください。 PlanAhead を起動する と、 最新の

バッ クアップ コピーが .jou_backup および .log_backup に保存されます。

http://japan.xilinx.com
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手順 3 : Tcl スクリプ トの実行

こ こまでは、デフォルトの GUI モードで PlanAhead を使用してきました。 PlanAhead には、 GUI、
インタラ クティブ シェル、 バッチ モードの 3 つのモードがあ り ます。

このセクシ ョ ンでは、 それぞれのモードで Tcl コマンドおよびスク リプ ト を実行してみます。

GUI モードでの Tcl スクリプ トの実行

PlanAhead のデフォルト  モードは GUI です。 Tcl コマンドは [Tcl Console] ビューに直接入力でき

るほか、 [Tools] メニューから実行するこ と もできます。

1. メモ帳、EMACS、VI のよ うなテキス ト  エディ タで step3.tcl とい うテキス ト  ファ イルを作

成し、 次のコマンドを記述します。

puts “Hello World!”

2. GUI で [Tools] → [Run Tcl Script] をク リ ッ ク し、[Run Script] ダイアログ ボッ クスを開きます

(図 1-4)。 

3. step3.tcl ファ イルを作成したディ レク ト リ を指定します。

4. ファ イルを選択します。

5. [OK] をク リ ッ ク します。

Figure X-Ref Target - Figure 1-4

図 1-4 : [Run Tcl Script] コマンドの実行
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[Tcl Console] ビューに“Hello World!” と表示されます。

Tcl スク リプ トは [Tools] メニューからだけでなく、[Tcl Console] ビューで次を入力しても起動

できます。 

>source <path_to_file>/step3.tcl

6. [File] → [Exit] をク リ ッ クするか、[Tcl Console] ビューで exit と入力して PlanAhead を終了し

ます。

コマンド  ラインからのスクリプ トの読み込み

PlanAhead を起動する際に Tcl コマンドを実行できます。 ファ イルを保存したディ レク ト リから

DOS ターミナル (cmd) または Linux シェル プロンプ トに -source コマンド  ライン オプシ ョ ンを

入力します。

1. PlanAhead を起動し、 作成した step3.tcl を実行します。

>planAhead –source step3.tcl

GUI モードで PlanAhead が起動され、指定した Tcl スク リプ トが読み込まれます。実行が終了

したら、GUI でコマンドを実行したり、 [Tcl Console] ビューに Tcl コマンドを入力できるよ う

にな り ます。

メモ : これは PlanAhead の実行ファイルがインス トールされ、 コマンド検索パス  (Linux では

$PATH、 Windows では %Path%) に存在している と仮定した場合です。 

PlanAhead の GUI が使用できない場合は、 次のいずれかのオプシ ョ ンを使用できます。

• ISE のインス トールに含まれる  settings32.bat または settings64.bat (Linux の場

合は .sh) 環境設定スク リプ ト を source コマンドで読み込みます。

• PlanAhead コマンドの前に PlanAhead のインス トール ディ レク ト リへのパスを付けま

す。

Figure X-Ref Target - Figure 1-5

図 1-5 : Tcl スクリプ ト  ファイルのプレビューと選択
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• <PlanAhead_install_dir>/PlanAhead/bin が実行検索パスに含まれるよ うに 
PATH 環境変数を変更します。

メモ : “Hello World” メ ッセージは、プロジェク ト を開くか作成するまで PlanAhead の [Tcl
Console] ビューには表示されません。 プロジェ ク ト を開くか作成したら、 メ イン ウ ィ ンド ウ

の左下のボタンを使用して [Tcl Console] ビューを展開表示する必要のある可能性があ り ます。

2. [File] → [Exit] をク リ ッ クするか [Tcl Console] ビューに exit と入力して PlanAhead を終了

します。

インタラクテ ィブ シェル モードの使用

PlanAhead には、GUI 以外のインタラ クティブ セッシ ョ ン用にインタラ クティブな Tcl シェル モー

ドが含まれます。 

1. インタラ クティブ シェル モードを実行するには、次のよ うに -mode オプシ ョ ンを使用します。

>planAhead –mode tcl 

GUI なしに直接コマンドを入力できる  PlanAhead シェル プロンプ ト  (PlanAhead%) が表示さ

れます。 すべての Tcl コマンドが使用でき、 コマンドをインタラ クティブに実行したり、 GUI
モード と同じよ うにプロジェク トやデザインを呼び出したりできます。 

2. PlanAhead ソフ ト ウェアを終了します。

>exit

インタラ クティブ シェル モードには、Tcl モードで PlanAhead を実行して、開始スク リプ ト を

-source で指定するオプシ ョ ンもあ り ます。 

3. Tcl モードでソフ ト ウェアを実行し、 スク リプ ト を source オプシ ョ ンで呼び出します。

>planAhead –mode tcl –source step3.tcl

4. help コマンドを入力し、 インタラ クティブ シェルでコマンド  ヘルプを表示します。

>help

5. PlanAhead ソフ ト ウェアを終了します。

>exit

バッチ モード  コマンドの使用

バッチ モードは GUI が起動されない点でインタラ クティブ モード と類似していますが、有効な Tcl
スク リプ ト を -source オプシ ョ ンで呼び出す必要がある点が異なり ます。 バッチ モードでは Tcl ス
ク リプ ト を実行したあと、 自動的に PlanAhead を終了します。

1. バッチ モードで -source オプシ ョ ンを付けて step3.tcl ファ イルを実行します。

>planAhead –mode batch –source step3.tcl 

これによ り、PlanAhead が起動されます。スク リプ トが起動され、実行されます。 この後、コマンド

を入力するインタラ クティブ シェル プロンプ ト を表示するこ とな く、 PlanAhead が閉じます。 
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Tcl の機能すべてに関する詳細な説明は、 このチュート リ アルではカバーし切れません。Tcl の基礎

に関する詳細は、 次の Web サイ ト を参照してください。

http://www.tcl.tk/doc/

• Tcl 参照情報

• Tcl 8.5 の入門用チュート リ アル

• PlanAhead 専用でないビルト イン コマンドに関する文書

メモ : PlanAhead には、 最新の Tcl リ リースのバージ ョ ン 8.5 が含まれています。

Tcl インタープリ ターと基本構文の理解

Tcl は変換済みスク リプ ト言語です。 Tcl コードをマシン コードやアセンブリ  コードにコンパイル

する必要はあ り ません。 Tcl には、 Tcl コマンドを入力と して使用し、言語の意味によってそれらを

評価するインタープリ ターがあ り ます。 コマンドで直接デザインに関する質問を入力して、 ツール

がそれに答える といったよ うなこ とができるので、 インタープリ タは EDA ツールへの優れたイン

ターフェイス となっています。

GUI の [Tcl Console] ビューと  インタラ クティブ シェル モードの planAhead% プロンプ トがこの

インタープリ ターへのインターフェイスです。これらのプロンプ トに直接コマンドをタイプする と、

これらのコマンドがインタープリ ターに渡され評価されます。 このインタープリ タは、 前の手順の

セクシ ョ ンで既に使っています。

Tcl コマンドの基本的な構文は、 次のとおりです。

<command> <options>

スク リプ トに複数のコマンドが含まれる場合は、 それが順番に評価されます。 コマンドは左から右

に向かって評価されます。

変数と置換の理解

Tcl の変数は set コマンドを使用する と作成できます。Tcl 言語は大まかに入力できるので、どのデー

タ型を変数に含めればいいか考慮しな くても、 データを維持する変数を作成できます。 

Tcl プログラムを実行してみます。

1. Tcl モード  (>planAhead –mode tcl) で PlanAhead を起動するか、インス トールしている場

合は Tcl シェル (tclsh) を起動します。

2. 次を入力して簡単な文字列変数を作成します。

>set var1 “Hello World!”

Hello World!

コンソールの履歴に 「Hello World!」 とい う文字列が出力されます。

3. 次のよ うに set コマンドを使用して、 変数を文字列、 整数、 浮動小数点に設定します。

>set var2 1

1

var2 の値が 1 に設定されます。

>set var3 3.14

3.14

http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=tcl+library+docs
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var3 の値が 3.14 に設定されます。

4. 次のよ うに、 新しい変数を置換のコンセプ ト を使用してほかの変数に設定してみます。

>set var4 $var1

Hello World! 

この例では、 $ マークは、 var4 へ代入を行う前に、 インタープリ ターに指定した名前の付いた

変数を検索して、その値を置換するよ うに伝えています。$ マークは Tcl の特殊文字で、覚えて

おく と便利です。 その他の Tcl の特殊文字には次のよ うなものがあ り ます。

置換されないよ うにするには、 次のいずれかを使用します。

• 文字列リテラルを { } で囲む

• 特殊文字の前にバッ クスラ ッシュを記述

5. 変数を $ を含む文字に設定する際にインタープリ ターで変数が置換されないよ うにするには、

次のいずれかのよ うに入力します。

>set var5 {$var4}

または

>set var5 \$var4

$var4

条件文の入力

Tcl では if 文による条件文がサポート されます。 次はその例です。 

1. 次のコマンドを [Tcl Console] ビューに入力します。

>if {$var2 == 1} {puts “Yay!”}

Yay!

この例では、{ } は他の文の本体を示します。インタープリ ターは var2 という変数が 1 と同じかど

うかチェッ ク し、 同じの場合は 2 つ目の { } の中のコマンドを実行します。 

表 1-1 : Tcl の特殊文字

文字 名前 ビヘイビア

[] 各かっこ 1 つのコマンドを別のコマンドへネ

ス ト

{} 波かっこ 文字列リテラル

“” 二重引用符 変数およびコマン ド置換の可能な

ス ト リ ング

\ バッ ク ス ラ ッ シュ または

エスケープ文字

インタープ リ ターが読み込まない

よ うに特殊文字の前に使用

; セミ コロン コマンドの終了

# シャープ文字 コ メン ト

$ ドル マーク 前に定義した変数の使用 
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if に elseif コマンドを追加

elseif キーワードを使用する と、 if/else 条件文に複数の else 条件を使用するこ とができます。 複

数の elseif 文をまとめて使用するこ とで、カスケード された条件を作成できます。次の例では、最初

の行で 3 つの条件がインプリ メン ト され、 var2 が 2 の場合は Yay! を、 var2 が 3.14 の場合は

Nay! を、 どちらの条件も満たさない場合は Maybe! が出力されます。 

1. 次のコマンドを [Tcl Console] ビューに入力します。

>if {$var2 == 2} {puts “Yay!”} elseif {$var3 == 3.14} {puts “Nay!”} else 
{puts “Maybe!”}

Nay!

リス トおよびループ

Tcl には、複数の値を維持できるコンテナ変数があ り ます。リ ス トはスペースで値を分けた文字列に

なり ます。 

リ ス トに含まれるものをすべて リ ス トするには、 foreach コマンドを使用します。 

1. 表 1-2 の colors リ ス トに含まれる色を リ ス トするには、 次を [Tcl Console] ビューに入力しま

す。

>foreach c $colors {puts $c}

red

blue

green

リ ス トがループ検索され、 含まれる色がすべて表示されます。

表 1-2 : Tcl 変数の例

コマンド 結果 説明

>set colors “red blue

green”

red blue green

>set colors2 [list

brown black white]

brown black white リ ス ト を構築するには、明示

的な リ ス ト  コマンドを使用

します。

>llength $colors 3 $colors リ ス トにアイテム

数が表示されます。

>lindex $colors 0 red $colors リ ス トに最初のア

イテムの値が表示されます。

>lindex $colors2 end white $colors リ ス トに最後のア

イテムの値が表示されます。
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ネス ト  コマンド

コマンドのネス ト とは、特殊文字の [ ] を使用し、ほかのコマンドの中に複数のコマンドを埋め込む

こ とです。 ネス ト されたコマンドは、 一番内部から外側に向かってインタープリ ターによ り実行さ

れます。 コマンドのネス トによ く使用されるのは演算コマンドの expr です。

>set var7 [expr 1 + 1]

2

>set var8 [expr $var3 / 10]

0.314

>set var9 [expr [expr 2 * 3] + 1]

7

コマンドはどれでもすべてネス トできます。 [ ] を使用するこ とでインタープリ ターで囲まれたコマ

ンドが評価され、 結果の値が次のコマンドへ代入されます。

エラー処理

Tcl スク リプ トでエラーがある と、通常はスク リプ トの実行が停止されます。Tcl にはエラー ト ラ ッ

プを処理するビルト イン機能があるので、実行を続行するかど うかユーザーが指定できます。catch

コマンドはどのコマンドでも引数と して取り入れ、 エラーがある場合は 1 を返します。

1. 次のコマンドを入力します。

>catch “junk” result

1

>puts $result

invalid command name “junk”

2. catch コマンドの結果は if 文と組み合わせる と、 エラーを処理できます。

>if {[catch “junk” result]} {puts “ERROR_IN_MY_SCRIPT!”}

ERROR_IN_MY_SCRIPT!

この場合、 catch コマンドは未知の junk コマンドから発生したエラーを取り込んで、 put コマ

ンドでコード  ブロ ッ クのコマンドを実行します。

3. PlanAhead ソフ ト ウェアまたは Tcl シェルを終了します。

>exit
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create_project コマンドで基本的なプロジェク ト作成を開始します。プロジェク ト作成には、次

を指定するオプシ ョ ンが必要です。

• プロジェク ト名

• プロジェク ト を作成するディ レク ト リ  

• ターゲッ ト とするデフォルト  パーツ

この手順では、小型プロジェク ト を作成するスク リプ ト を作成し、バッチ モードで RTL 合成を実行

します。

プロジェク トの作成

1. step5.tcl という新しい名前のファイルを作成します。

次に、 このファイルにコマンドを追加します。

2. step5.tcl ファ イルに次の基本的な変数定義を入力またはコピーしておきます。

<EXTRACT_DIR> は正しいパスに変更してください。

set projDir [file dirname [info script]]

set srcDir  <EXTRACT_DIR>/PlanAhead_Tutorial/Sources/hdl/

set projName usbf

set topName usbf_top

set device xc6vlx75tff484-1

これらのコマンドでは、 次が実行されます。

• [info script] コマンドでは、 Tcl インタープリ ターで実行されたスク リプ トの完全な

ファイル名が返されます。 

• ファ イル名が file dirname コマンドに渡され、 スク リプ トのあるディ レク ト リが返さ

れます。 スク リプ トがあるのと同じディ レク ト リにプロジェク ト を作成します。

3. ディ レク ト リが存在しているかど うか確認し、存在している と きは次を入力して削除しします。

if {[file exists $projDir/$projName]} {

   # if the project directory exists, delete it and create a new one

   file delete -force $projDir/$projName

}

4. 次を入力して、手順 2 で作成したプロジェク ト名、ディ レク ト リ 、 ターゲッ ト  パーツの変数を

使用し、 create_project コマンドで新規プロジェク ト を作成します。

create_project $projName $projDir/$projName -part $device 

5. ソース  セッ トの design_mode プロパティを設定します。

set_property design_mode RTL [get_filesets sources_1]

これによ りプロジェク トがすべての RTL ソース  ファ イルのコンテナ オブジェク トである

RTL プロジェク トに設定されます。合成後のネッ ト リ ス トに基づいたネッ ト リ ス ト  ベースのプ

ロジェク ト を作成する場合、 このプロパティは RTL ではなく  Netlist にします。
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6. 次を入力し、 RTL ソースを定義してプロジェク トに追加します。

set verilogSources [glob $srcDir/FifoBuffer.v $srcDir/async_fifo.v 
$srcDir/rtlRam.v $srcDir/$projName/*.v]

Tcl には、ワイルドカード検索のよ うに、すべてのファイルをクエ リー検索する  glob という ビ

ルト イン コマンドが含まれます。[Tcl Console] ビューに help glob と入力する と、このコマ

ンドの詳細を確認できます。

7. 次のよ うに import_files コマンドを入力し、 ソース  ファ イルをプロジェク トに追加して

ローカルにコピーします。

import_files -fileset [get_filesets sources_1] -force -norecurse 
$verilogSources

このコマンド文字列では、各ファイルがプロジェク トにインポート され、fileset という コンテナ

オブジェク トに入れられます。デフォルトの fileset は sources_1 という名前になり、 これら

のファイルを保存します。 

このコマンドには、 次のオプシ ョ ンを使用できます。

• –force オプシ ョ ンを使用する と、 前のソースがすべて同じ名前で上書きされます。

• –norecurse オプシ ョ ンを使用する と、 PlanAhead で各サブディ レク ト リ を繰り返し検

索して検出されたファイルが追加されないよ うにな り ます。

8. 最上位レベルのモジュールまたはエンテ ィテ ィ名を最上位レベルを合成するよ うに設定しま

す。

set_property top $topName [get_property srcset [current_run]]

9. 作成した step5.tcl ファ イルを保存し、 -source オプシ ョ ンで呼び出します。

>planAhead –mode batch –source step5.tcl

PlanAhead が起動され、 スク リプ トに基づいてプロジェク トが作成され、 スク リプ トが終了す

る と  PlanAhead が閉じられます。

プロジェク ト を合成するコマンドを追加 
前の手順では、スク リプ ト を記述して RTL プロジェク ト を作成しました。 この手順では、デフォル

トの合成ス ト ラテジを使用して合成を実行するコマンドを追加します。 

1. step5.tcl をテキス ト  エディ ターで開き、 次のコマンドをスク リプ トの終わりの 
set_property top コマンドの後に追加します。

launch_runs -runs synth_1

PlanAhead の GUI で合成またはインプリ メンテーシ ョ ンを実行する と、PlanAhead はプロセス

を別のスレッ ドで起動するので、 GUI を続けて使用してデザインを解析できます。 

Tcl も同じで、何か特別なこ とをしな くても合成が実行されます。この場合、バッチ モードで実

行しているので、 合成の実行が終了するまでに実行をブロ ッ クするコマンドを入力する必要が

あ り ます。 こ うするこ とで、 インプリ メンテーシ ョ ンを実行する次の手順が問題なく実行でき

ます。

2. 実行をブロ ッ クするコマンドは、 次のよ うに入力します。

wait_on_run synth_1

3. step5.tcl ファ イルを保存します。
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4. PlanAhead を実行し、 作成したスク リプ ト を -source で呼び出します。

>planAhead –mode batch –source step5.tcl

PlanAhead は前のプロジェク ト を削除し、 作成し直してから、 デフォルトの合成ス ト ラテジを

使用して合成を実行します。 PlanAhead には多くの合成ス ト ラテジがビルト インされており、

別のス ト ラテジを選択するのは、合成のス ト ラテジ プロパティの設定およびリ コンパイルと同

じよ うに簡単です。

5. step5.tcl の launch_runs synth_1 コマンド前に次のコマンドを追加します。

set_property strategy PowerOptimization [get_runs synth_1]

これによ り、 電力最適化ス ト ラテジが選択されます。

6. step5.tcl ファ イルを保存します。

7. PlanAhead を実行し、 作成したスク リプ ト を -source で呼び出します。

>planAhead –mode batch –source step5.tcl

PlanAhead は前のプロジェク ト を削除し、 新しいプロジェク ト を作成し、 電力最適化ス ト ラテ

ジを使用して合成を実行します。

インプリ メンテーシ ョ ンの起動

前の手順では、 スク リプ ト を作成し、 XST を使用してそのプロジェク ト を合成しました。 

今度は、 インプリ メンテーシ ョ ンを実行するコマンドを追加して、 スク リプ ト を実行します。

1. step5.tcl をテキス ト  エディ ターで開き、 次のコマンドをスク リプ トの終わりの 
wait_on_run synth_1 コマンド後に追加します。

launch_runs -runs impl_1

wait_on_run impl_1

合成 run の場合と同様、 これらの 2 つのコマンドはデフォルトのス ト ラテジを使用してインプ

リ メンテーシ ョ ンを起動し、 終了するまでブロ ッ ク します。

2. step5.tcl ファ イルを保存します。

3. PlanAhead を実行し、 作成したスク リプ ト を -source で呼び出します。

>planAhead –mode batch –source step5.tcl

このスク リプ トは、前のプロジェク ト を削除し、作成し直してから、デフォルト  ス ト ラテジを

使用してインプリ メンテーシ ョ ンを実行します。 

4. タイ ミ ング ド リブン マップ フローのよ うな別のインプリ メンテーシ ョ ン ス ト ラテジを使用す

る場合は、 launch_runs –runs impl_1 コマンドの前に次のコマンドを追加します。

set_property strategy MapTiming [get_runs impl_1]

5. step5.tcl ファ イルを保存します。

6. PlanAhead を実行し、 作成したスク リプ ト を -source で呼び出します。

>planAhead –mode batch –source step5.tcl

このスク リプ トは、前のプロジェク ト を削除し、作成し直してから、map –timing フローを使

用してインプリ メンテーシ ョ ンを実行します。
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インプリ メンテーシ ョ ン結果を開く

合成またはインプリ メンテーシ ョ ン run が終了した後、 [Netlist Design] または [Implemented
Design] を開き、 メモ リに読み込んで、PlanAhead ソフ ト ウェアでアクティブにします。 この後、 こ

のアクティブ デザインで Tcl コマンドや操作をさらに実行できます。 

1. インプリ メンテーシ ョ ン後のネッ ト リ ス ト を開くには、step5.tcl の最後に次を追加します。

open_impl_design

2. step5.tcl ファ イルを保存します。

3. PlanAhead を実行し、 作成したスク リプ ト を -source で呼び出します。

>planAhead –mode tcl –source step5.tcl

PlanAhead% プロンプ トが表示されたら、 次を入力して GUI を起動します。

 PlanAhead% start_gui

このスク リプ トは、 前のプロジェク ト を削除し、 作成し直してから、 インプリ メンテーシ ョ ン

フローを実行し、 今後の解析および操作用にインプリ メンテーシ ョ ン結果を開きます。 

メモ : プロセスが終了した後に常に GUI を起動するよ うに設定するには、 start_gui コマン

ドを step5.tcl スク リプ トの最後に追加しておきます。

4. PlanAhead を終了します。

>exit
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手順 6 : ネッ ト リス ト  オブジェク ト、 プロパティ、 物理制約の確認

前の手順では、 プロジェク ト を作成し、バッチ モードで Tcl を使用して単純なフローを実行しまし

た。 この手順では、SDC コマンドを使用してネッ ト リ ス ト  アクセス  コマンドをさ らに確認します。

プロジェク ト を開く

1. テキス ト  エディ ターで、step6.tcl という ファ イルを前と同じディ レク ト リに作成し、次のコ

マンドを入力またはコピーします。 <EXTRACT_DIR> には、 正しいパスを使用してください。

set projDir [file dirname [info script]]

set srcDir <EXTRACT_DIR>/PlanAhead_Tutorial/Projects/

set projName project_cpu_netlist

set topName top

set device xc6vlx75tff484-1

# open existing project

open_project $srcDir/$projName/$projName.ppr

# now open the post-synthesis netlist design

open_netlist_design

2. step6.tcl ファ イルを保存します。

3. PlanAhead を実行し、 作成したスク リプ ト を -source で呼び出します。

>planAhead –source step6.tcl

PlanAhead が起動し、プロジェク トが開き、ネッ ト リ ス ト  デザインが読み込まれ、 さ らにコマ

ンドを実行できる状態になり ます。

オブジェク ト とプロパテ ィの確認

まず、 PlanAhead でよ く使用されるオブジェク ト  タイプを確認します。 run オブジェク トのプロパ

ティを確認しておく と、 フロー制御しやすくな り ます。 これは、 プロジェク ト を検索して現在のプ

ロジェク ト  ステータスを決定する際に便利です。[Tcl Console] ビューを最大化して結果を見やすく

しておきます。

1. [Tcl Console] ビューに次のコマンドを入力し、 run オブジェク トのプロパティを確認します。

>set runList [get_runs]

>report_property [lindex $runList 0]

>get_property status [lindex $runList 0]

これらのコマンドは、Tcl を使用して検索可能な run プロパティを示します。インプリ メンテー

シ ョ ンはまだ実行していないので、 インプリ メンテーシ ョ ン run の impl_1 のステータスは、

「Not Started」 になっているはずです。

最もよ く使用される  SDC コマンドは get_cells コマンドで、 ネッ ト リ ス ト  デザインのイン

スタンスを名前で検索できます。 –hierarchical オプシ ョ ンを使用する と、 PlanAhead にデ

ザインの各階層レベルで提供されるパターンを適用するよ うに命令されます。次のコマンドは、

デザインに含まれるすべてのセルを返します。 
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2. [Tcl Console] ビューに次のコマンドを入力し、 セル オブジェク トのプロパティを確認します。

>set cellList [get_cells -hierarchical *]

>report_property [lindex $cellList end]

>get_property lib_cell [lindex $cellList end]

これらのコマンドは、デザインのすべてのセルを検索し、 リ ス トの最後のセルのプロパティ  レ
ポート を表示します。最後のコマンドでは、プリ ミ ティブ ラ イブラ リのセル プロパティの値が

返されます。

get_nets コマンド もよ く使用されるオブジェク ト検索 コマンドで、階層検索パターンが指定

できます。 

3. [Tcl Console] ビューに次のコマンドを入力し、 ネッ ト  オブジェク トのプロパティを確認しま

す。

>set netList [get_nets *]

>report_property [lindex $netList 0]

>get_property type [lindex $netList 0]

これらのコマンドは、階層の最上位レベルにあるネッ ト  オブジェク ト をすべて検索し、 リ ス ト

の最初のもののプロパティ値のレポート を表示します。 最後のコマンドでは、 type プロパティ

が検索され、 信号の型が返されます。

ポート  オブジェク トは get_ports コマンドで検索されます。 

4. 次のコマンドを入力し、 ポート  オブジェク ト とそれらのプロパティを確認します。

>set portList [get_ports *]

>report_property [lindex $portList 0]

>get_property iostandard [lindex $portList 0]

これらのコマンドは、最上位レベルのポートすべてを返し、スク リプ トに使用可能なプロパティ

のリ ス ト を表示します。最後に、ポートに適用された I/O 規格が get_property コマンドで検

索され、 LVCMOS25 が表示されます。

ピン オブジェク トは、 get_pins コマンドを使用して検索できます。 

5. [Tcl Console] ビューに次のコマンドを入力し、 ピン オブジェク トのプロパティを確認します。

>set pin [get_pins OpMode_pad_0_o_0/D]

>report_property $pin

>get_property setup_slack $pin

これらのコマンドは特定ピン、フ リ ップフロ ップへの D 入力を検索し、ピン オブジェク トに使用可

能なプロパティすべてをレポート します。ピン オブジェク トはスタティ ッ ク  タイ ミ ング解析エンジ

ンと関連しており、ピンはセッ ト アップまたはホールド  スラ ッ ク  プロパティに基づいて検索できま

す。 タイ ミ ング解析関連のプロパティを検索する と、 タイ ミ ング グラフを作成するタイ ミ ング解析

エンジンが起動されます。 これは、 デバッグおよび解析に便利な機能です。

プロパティ を使用してオブジェク ト検索をフ ィルター

-filter オプシ ョ ンを get_ コマンドに組み合わせて使用する と、特定の要件に基づいて返された

オブジェク トの リ ス ト をフ ィルタできます。次に、オブジェク ト  アクセス  コマンドにフ ィルタを付

けた例を示します。 

1. 次のコマンドを [Tcl Console] ビューに入力します。

>get_nets -filter {type == "Global Clock"}
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>set cellList [get_cells * -hierarchical -filter "lib_cell =~ FD*"]

最初のコマンドは、グローバル ク ロ ッ ク  ネッ ト を検索し、2 つ目のコマンドはプリ ミ ティブ タ
イプが FD で始まる文字列パターンと一致するセルのリ ス ト を返します。 これによ り、FDR プ
リ ミ テ ィブのよ う な、 デザインに含まれるフ リ ップフロ ップがすべて返されます。 lib_cell

オブジェク ト  プロパティは Unisim プリ ミ ティブに直接マップされます。

オブジェク ト同士は、ネッ ト リ ス ト接続によ り互いに関連しています (ポートがネッ トに、ネッ

トがピンに、 ピンがセルに接続)。 

オブジェク ト  アクセス  コマンドに –of オプシ ョ ンを使用する と、ネッ ト リ ス ト  オブジェク ト

を指定して検索ができます。 

2. これらのコマンドを確認するには、 次のコマンドを [Tcl Console] ビューに入力します。

>set cell [get_cells fftEngine/control_reg_1]

>set pin [lindex [get_pins -of $cell -filter "direction == IN"] 1]

>set net [get_nets -of $pin]

>set driver [get_pins -of $net -filter “direction == OUT”]

>set driverCell [get_cells -of $driver]

これらのコマンドを使用する と、 接続関係が検索され、 さまざまなプロパティおよび接続情報

に基づいてネッ ト リ ス トが指定できるので便利です。

物理制約の確認

物理制約を確認しておく と便利ですが、Tcl で物理制約の値を UCF と同じ方法で設定できるよ うに

しておく必要があ り ます。 次は UCF ではなく、 Tcl を使用して物理制約を設定する例です。

1. [Tcl Console] ビューに次のコマンドを入力し、 適用される物理制約を確認します。

>set_property IOSTANDARD SSTL15 [get_ports cpuClk]

>set_property site IOB_X1Y72 [get_ports cpuClk]

>set_property is_fixed true [get_ports cpuClk]

>set_property loc SLICE_X0Y73 [get_cells fftEngine/control_reg_1]

>set_property bel AFF [get_cells fftEngine/control_reg_1]

>set_property is_fixed true [get_cells fftEngine/control_reg_1]

これらのコマンドは IOSTANDARDS、 LOC、 および BEL 制約のよ うな物理制約を設定しま

す。 HDL で適用できる属性のほとんどは EDIF ネッ ト リ ス トの属性に伝搬され、

get_property で検索でき、 set_property で設定できます。 オブジェク トのプロパティす

べてを確認する場合は、 report_property コマンドを使用します。

2. PlanAhead を閉じます。

• [Tcl Console] ビューに exit と入力します。

• [File] → [Exit] をク リ ッ ク します。

• メ イン ウ ィンド ウ右上の X マークをク リ ッ ク します。 
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手順 7 : Tcl および SDC を使用したスタテ ィ ック  タイ ミング解析 
PlanAhead には、TRACE (ISE Design Suite の STA エンジン) とは異なるスタティ ッ ク  タイ ミ ング

解析 (STA) エンジンが含まれます。 PlanAhead の STA エンジンは、 SDC (Synopsys Design
Constraints) 制約と互換性があ り、 インク リ メンタル タイ ミ ング解析をサポート します。 

この手順では、 単純な UCF タイ ミ ング制約ファイルを SDC に変換します。 SDC は現在のと ころ

PlanAhead でのみサポート されているので、タイ ミ ング制約は ISE インプリ メンテーシ ョ ンおよび

タイ ミ ング解析ツールにはそのまま使用できませんが、 ネッ ト リ ス トの解析およびデバッグに優れ

ています。 SDC は主にタイ ミ ング制約に使用されるので、 このセクシ ョ ンでは、 特にクロ ッ ク、

I/O 制約、 例外といった基本的な SDC について説明します。

UCF 変換の設定 
この手順では、サンプル プロジェク トの 1 つを開き、別の名前で保存して、SDC 制約が適用される

よ う、 UCF ベースのタイ ミ ングが伝播されないよ うに設定します。

1. テキス ト  エディ ターで、step7.tcl という ファ イルを前と同じディ レク ト リに作成し、次のコ

マンドを入力またはコピーします。 $srcDir 変数の <EXTRACT_DIR> は正しいパスに変更し

て ください。

set projDir [file dirname [info script]]

set srcDir <EXTRACT_DIR>PlanAhead_Tutorial/Projects/

set projName project_cpu_netlist

set topName top

set device xc6vlx75tff484-1

# open project

open_project $srcDir/$projName/$projName.ppr

# rename the project 

set projName ${projName}SDC

# save it to a new name and location

if {[file exists $projDir/$projName]} {

   # if the project dir exists, delete it and create a new clean one

   file delete -force $projDir/$projName}

save_project_as $projName $projDir/$projName

# now disable all ucf files - in preparation for SDC

set_property is_enabled false [get_files *.ucf] 

# now open the implementation results

open_netlist_design

2. step7.tcl を保存します。 
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3. PlanAhead を実行し、 作成したスク リプ ト を -source で呼び出します。

>planAhead –source step7.tcl

このコマンドは、 デザインを開き、 新しい名前でそれを保存し、 デザインを開いた状態で GUI
を起動します。 プロジェク トは GUI から手動で開いて、 名前を変更するこ と もできます。 

クロックの管理

この手順では、 ファ イルを作成してクロ ッ クを追加します。 後の手順で、 制約を追加し、 このファ

イルを繰り返し  -source で読み込んで、インク リ メンタル スタティ ッ ク  タイ ミ ング解析を使用して

タイ ミ ング制約をデバッグします。

こ こでは、 次の UCF TIMESPEC 制約を同等の create_clock という  SDC 制約に置き換えます。

# Timing Constraints:

TIMESPEC TS_cpuClk = PERIOD "cpuClk" 13 ns;

NET "cpuClk" TNM_NET = "cpuClk";

TIMESPEC TS_wbClk = PERIOD "wbClk" 9 ns;

NET "wbClk" TNM_NET = "wbClk";

TIMESPEC TS_usbClk = PERIOD "usbClk" 5.25 ns;

NET "usbClk" TNM_NET = "usbClk";

TIMESPEC TS_phy_clk_pad_0_i = PERIOD "phy_clk_pad_0_i" 11 ns;

NET "phy_clk_pad_0_i" TNM_NET = "phy_clk_pad_0_i";

TIMESPEC TS_phy_clk_pad_1_i = PERIOD "phy_clk_pad_1_i" 11 ns;

NET "phy_clk_pad_1_i" TNM_NET = "phy_clk_pad_1_i";

TIMESPEC TS_fftClk = PERIOD "fftClk" 7 ns;

NET "fftClk" TNM_NET = "fftClk";

メモ : UCF からの TIMESPEC PERIOD 制約は SDC の create_clock コマンド と同じです。 

1. テキス ト  エディ ターを使用し、 top.sdc という新しいファイルを作成します。 

2. top.sdc ファ イルに次を入力します。

create_clock -name cpuClk -period 13 [get_ports cpuClk]

このコマンドは、 周期 13ns の cpuClk という ク ロ ッ クを作成し、 cpuClk という最上位レベル

ポートから  6.5ns で立ち上がるよ うに設定しています。 

3. top.sdc ファ イルに次を入力して、 ほかのクロ ッ クを追加します。

create_clock -name wbClk -period 9 [get_ports wbClk]

create_clock -name usbClk -period 5.25 [get_ports usbClk]

create_clock -name phy_clk_0 -period 11 [get_ports phy_clk_pad_0_i]

create_clock -name phy_clk_1 -period 11 [get_ports phy_clk_pad_1_i]

create_clock -name fftClk -period 7 [get_ports fftClk]

4. 現在の作業ディ レク ト リに top.sdc を保存します。 
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5. PlanAhead の [Tcl Console] ビューから  top.sdc を -source で読み込んでクロ ッ クを作成しま

す。

>source top.sdc

メモ : 作業ディ レク ト リが top.sdc ファ イルを保存したディ レク ト リ と異なる場合は、 代わ

りに次を入力します。 

>source $projDir/top.sdc

[Tcl Console] ビューには、create_clock コマンドがコ メン ト と して表示され、最後のコマン

ドで作成されたクロ ッ ク名が fftClk と表示されます。

6. 新規作成したクロ ッ クを含めたタイ ミ ング結果を確認するには、 report_timing コマンドを

実行します。

>report_timing

タイ ミ ング エンジンが起動され、ワース ト ケースのタイ ミ ング パスがデフォルトで表示されま

す。

入力制約の追加

次に、 UCF の OFFSET IN 制約と同等の入力タイ ミ ング関係を設定します。 次は、 その例です。

NET "DataIn_pad_0_i[0]" OFFSET = IN 3 ns VALID 7 ns BEFORE "TS_usbClk" 
RISING;

1. top.sdc の最後に次を追加します。

set_input_delay -clock phy_clk_0 -max 2.25 [get_ports 
{DataIn_pad_0_i[0]}]

set_input_delay -add_delay -clock phy_clk_0 -min 4 [get_ports 
{DataIn_pad_0_i[0]}]

最初の制約は、DataIn_pad_0_i[0] 信号が phy_clk_0 ク ロ ッ ク  ド メ インの立ち上がりエッ

ジの 2.25n ｓ  後に到着するこ とを示しています。2 つ目の制約は、OFFSET IN の VALID 範囲

と同等の最小遅延 (ホールド解析) を提供します。2 つ目の制約の –add_delay は、最小遅延値

を追加する際に前に定義された最大遅延を保持するよ うにタイ ミ ング エンジンに伝えるため

のオプシ ョ ンです。

2. 現在の作業ディ レク ト リに top.sdc を保存します。 

PlanAhead には、同じ  SDC ファ イル何度も読み込むこ とのできるよ うに、すべてのタイ ミ ング

制約を削除するコマンドが含まれます。 

3. [Tcl Console] ビューのテキス ト  ボッ クスに次を入力します。

>reset_timing

>source top.sdc

4. ク ロ ッ クを含めたタイ ミ ング結果を確認するには、 report_timing コマンドを実行します。

>report_timing -from [get_ports {DataIn_pad_0_i[0]}]

タイ ミ ング パスを確認する と、スラ ッ クが 6.488ns であるこ とがわかり ます。データ  パス遅延

は 2.262ns です。 phy_clk_0 の create_clock でクロ ッ ク周期は 11ns と定義し、

DataIn_pad_0_i[0] の入力遅延を 2.25ns に設定したので、レポート されるのが 11 – 2.262 –
2.25 = 6.488 になり ます。
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出力制約の追加

次に、 OFFSET OUT 制約の指定に従って出力信号要件に制約を付ける必要があ り ます。 SDC の同

等のコマンドは、 set_output_delay です。 次は、 このプロジェク トの UCF の例です。

NET "DataOut_pad_0_o[0]" OFFSET = OUT 4 ns AFTER "TS_usbClk" RISING;

1. top.sdc の終わりに次の制約を追加します。

set_output_delay -clock wbClk 1.25 [get_ports {DataOut_pad_0_o[0]}]

2. 現在の作業ディ レク ト リに top.sdc を保存します。 

3. PlanAhead の [Tcl Console] ビューの Tcl コマンドテキス ト  ボッ クスに次を入力して、 タイ ミ

ングを リセッ ト し、 -source で top.sdc で制約を作成し直します。

>reset_timing; source top.sdc

メモ : コマンドの後のセミ コロン ( ; ) は、複数のコマンドを同じ行に含める と きに使用します。

Tcl イ ン タープ リ ターはセ ミ コ ロンの前の reset_timing コマン ド をまず実行してから、

source top.sdc を実行します。

4. 新しい設定のタイ ミ ング結果を確認するには、 report_timing コマンドを実行します。

>report_timing -to [get_ports {DataOut_pad_0_o[0]}] 

タイ ミ ング レポート を確認する と、スラ ッ クが 1.939ns であるこ とがわかり ます。データ  パス

遅延は 5.811ns です。wbClk の周期は 9ns に定義し、出力遅延は 1.25ns に設定したので、スラ ッ

クを計算する と、 レポート と同じ  9 – 5.811 – 1.25 = 1.939 になり ます。

この段階までで、top.sdc を修正するたびにタイ ミ ング グラフを reset_timing で削除して

からタイ ミ ング解析グラフを作成しなおしてきましたが、これは必ずしも必要ではあ り ません。

制約および例外を [Tcl Console] ビューに直接入力するこ とで、 インク リ メンタル STA の機能

を使用できます。

マルチサイクル パスの使用

次にマルチサイクル パスを UCF から  SDC 用に変換します。 マルチサイ クル パスは、 TIMESPEC
乗算器の付いた UCF の FROM/TO 制約と同じです。 次は、 このプロジェク トの例です。 

# Multi-cycle paths for ALU:

NET "cpuEngine/or1200_cpu/or1200_alu/*" TPTHRU = "GRP_ALU_DATAOUT";

TIMESPEC TS_ALU_MCP = FROM "cpuClk" THRU "GRP_ALU_DATAOUT" TO "cpuClk" 
TS_cpuClk * 2;

フ リ ップフロ ップへのタイ ミ ングを緩めて、セッ ト アップを満たすまで 2 ク ロ ッ ク  サイクル指

定するために、 SDC コマンドの set_multicycle_path を使用します。 

1. 次のコマンドを PlanAhead の [Tcl Console] ビューに入力します。

>report_timing -through [get_pins cpuEngine/or1200_cpu/or1200_alu/*]
>set_multicycle_path -through [get_pins cpuEngine/or1200_cpu/or1200_alu/*] 2
>report_timing -through [get_pins cpuEngine/or1200_cpu/or1200_alu/*]

最初のコマンドは、インク リ メンタル STA アップデート を実行し、デザインのピン数からタイ

ミ ング レポート を生成します。 ワース ト ケースのタイ ミ ング パスには、 3.835ns のスラ ッ クが

あ り ます。

2 つ目のコマンドは、パスに新しい制約を設定し、 タイ ミ ングを満たすために 2 ク ロ ッ ク  サイ

クルを使用できるよ うに指定しています。

3 つ目のコマンドは、新しい制約の影響を受けるタイ ミ ング グラフの部分だけをアップデート

し、別のインク リ メンタル STA アップデート を実行します。 この結果、 このパスに必要な時間
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が 13ns から  26ns に変更され、タイ ミ ングを満たすために 2 ク ロ ッ ク周期が含まれるよ うにな

り、 スラ ッ クは 16.835ns になり ました。

False パスの使用

False パスでもマルチサイクル パスと同様に、UCF に TIG 制約と同等の SDC コマンドをインク リ

メンタルに追加できます。この場合、実行するコマンドは set_false_path です。解析をしやすく

するために、出力ピンへのパスはすべて無視するこ とをお勧めします。 ク ロ ッ ク  ド メ イン間のタイ

ミ ングは、 どれも  UCF 制約を使用した TRACE で実行されるタイ ミ ングに対するデフォルトにな

り ません。SDC ベースのタイ ミ ングの場合、デフォルトの推測はすべてクロ ッ クに関連します。SDC
を使用して同じビヘイビアを取得するには、関連のないクロ ッ ク  ド メ イン間に False パスを明確に

設定する必要があ り ます。

1. 次のコマンドを [Tcl Console] ビューに入力します。

>report_timing -from [get_clocks cpuClk]

>set_false_path -from [get_clocks cpuClk] -to [get_clocks wbClk]

>set_false_path -from [get_clocks wbClk] -to [get_clocks cpuClk]

>report_timing -from [get_clocks cpuClk]

最初の report_timing コマンドはエラー パスを表示しますが、 cpuClk と  wbClk 間のパス

なので、有効なパスではあ り ません。これらのクロ ッ ク  ド メ イン間に 2 つの False パス  コマン

ドを設定し、 タイ ミ ングを再実行しました。 この結果、 クロ ッ ク  ド メ イン間にはタイ ミ ング計

算が実行されなくなっています。 

2. PlanAhead ソフ ト ウェアを終了します。

>exit

メモ : タイ ミ ング例外すべてと同様に、 False パス とマルチサイ クル パス制約も処理する必要

があ り ます。 デフォルトの解析を上書きするので、 これらのコマンドが正しいかど うか必ず確

認して ください。 追加したタイ ミ ング例外のために、 有効なパスの違反が非表示になるこ と も

あ り ます。

まとめ

このチュート リ アルでは、 次を実行しました。

• サンプル デザインを使用して、 Tcl コンソール、 GUI と  Tcl コマンド間の関係、 およびジャー

ナル ファ イルなどを確認しました。

• Tcl を使用して PlanAhead プロジェク ト を開く方法を学びました。

• Tcl コンソール、 Tcl コマンドのオンライン ヘルプの使用方法を学びました。

• PlanAhead のさまざまな実行モードについて学びました。

• 基本的な Tcl ビルト イン コマンドをいくつか確認しました。

• プロジェク ト を作成してフローを実行するバッチ モードのスク リプ ト を作成しました

• Tcl オブジェク ト、 プロパティ、 物理制約を確認しました。

• UCF タイ ミ ング制約を同等の SDC に変換し、インク リ メンタルなスタティ ッ ク  タイ ミ ング解

析レポート を確認しました。
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